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Figure 4.12 The Photoshop Color Settings. All the Photoshop color settings can be managed from
within this single dialog. Photoshop conveniently ships with seven preset settings which are suited to
various publishing workflows. As you move the cursor pointer around the Color Settings dialog, help
messages are provided in the Description box area below – these provide useful information which
will help you learn more about the Photoshop color management settings and the different color
space options.

The Color Settings

The Color Settings command is located in the Photoshop or Edit menu (depending
on which operating system is used). This Color Settings interface is more or less
identical to that found in Illustrator 9.0 or later and Figure 4.12 shows the basic
dialog controls and options. The first item you will come across is the Settings pop-
up menu. Photoshop helpfully provides a range of preset configurations for the color
management system. These can be edited (see Managing the Color Settings, page
80) if you wish them to meet your own specific requirements. The default setting
will say ‘Web Graphics Default’. If you want to edit your photographs with a view to
outputting color separated CMYK files for prepress in Europe, you would select the
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Default Prepress – Europe setting from this list. A prepress color setting will also be
an ideal starting point for any type of color managed workflow. That is all you need
to concern yourself with to start with, but if you wish to make customized adjust-
ments, then you can select custom settings in the Working Spaces section below.
Refer back to the section on RGB spaces for guidance on selecting the most
appropriate RGB space here. The CMYK and Grayscale settings shall be covered later.

Color management policies

Now when a document is opened, Photoshop checks to see if an ICC profile is present.
If so, the default policy is to preserve the embedded profile information. So whether
the document has originated in sRGB, Adobe RGB or ColorMatch RGB, it will open
in that RGB color space and after editing be saved as such (although with these
default settings the opening profile mismatch dialog offers you a chance to convert
to the current work space or discard the profile). You can have several files open at
once and each can be in an entirely different color space. If you have only got
accustomed to the Photoshop 5.0 and 5.5 way of doing things, this might take a little
getting used to. A good tip is to set the Status box to show ‘Document profile’ (on the
Mac this is at the bottom left of the image window; on the PC at the bottom of the
system screen palette). This will give you a constant readout of each individual
document’s color space profile.

The default policy of Preserve Embedded Profiles allows Photoshop users to use the
ICC color management system straight away, without confronting a puzzling ‘Con-
vert Colors’ dialog all the time. So long as there is a profile tag embedded in any file
you open, Photoshop will give you the option to open the file in that same color
space without converting it. So if someone asks you to open their Apple RGB file,
the default choice offered to you upon opening is to open it in the Apple RGB color
space and after saving it, the file will remain in and be tagged with this same Apple
RGB color space. This is despite the fact that your default RGB work space might in
fact be Adobe RGB. Photoshop will automatically adjust the monitor display to take
into account the monitor ICC profile created with Adobe Gamma (or other selected
monitor profile). There is no Display Using Monitor Compensation button to check
or uncheck in this version and a good thing too! So many people innocently played
around with the RGB settings in Photoshop 5.0 and ended up with bizarre
configurations which only served to confuse matters (these are still accessible, but
are safely hidden away under the Advanced settings). Now, you simply choose an
appropriate RGB color work space and that’s it. There is no Gamma or Primaries
option to meddle with. You are given access to only the necessary range of options.
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If you select the Convert to Working RGB policy, then Photoshop will behave more
like Photoshop 5.0 and 5.5. If the incoming profile does not match the work space,
then the default option will be to ask Photoshop to carry out a profile conversion
from the embedded profile space to your current work space. The same policy rules
apply to CMYK and grayscale files. When Preserve Embedded Profiles is selected,
Photoshop will read the CMYK or Grayscale profile, preserve the numeric data and
not convert the colors. And the image will remain in the tagged color space – this is
going to be the preferred option when editing incoming CMYK files. You normally
do not want to change the CMYK colors, a CMYK file may already be targeted for a
specific press output and you don’t really want to alter those CMYK numeric color
values. When the incoming profile matches the current RGB, CMYK or grayscale
work space, there is of course no need to convert the colors.

Figure 4.13 If Preserve Embedded Profiles is selected as the RGB color management policy, the
above dialog will appear, asking if you want to use the embedded profile. This happens whenever a
profile mismatch occurs and you have checked the Profile Mismatch: Ask When Opening box in Color
Settings (see Figure 4.15). If the color management policy is Convert to Work space color, the second
radio button will be highlighted in this dialog, asking if you wish to convert the colors to the current
work space. In Photoshop 7.0 the file name is now identified in this dialog.

Figure 4.14 If you attempt to paste image data from a document whose color space does not match
the destination space, the above dialog warning will appear, providing the Profile Mismatch: Ask When
Pasting box in the Color Settings dialog is checked (see Figure 4.12).
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The third option is Color Management: Off. With this configuration, Photoshop will
not attempt to color manage incoming documents. If there is no profile embedded,
then it will stay that way. If there is a profile mismatch between the source and work
space, the profile will be removed (with a warning alert, pointing out that the embed-
ded profile information is about to be deleted). If the source profile matches the work
space, there is no need to remove the profile, so in this instance the profile tag will not be
removed (even so, you can still remove the ICC profile at the saving stage).

The default settings make it easy for users to select an appropriate combination of
color setting configurations with a single mouse-click. Also, the default color man-
agement policy will allow you to open up documents which, if they do not match
your current work space, you can still continue to edit in that source space and save
them with the original profile accurately intact. A newcomer does not necessarily
have to fully understand how Photoshop color management works in order to suc-
cessfully start working in an ICC color managed workflow. They can open up legacy
files tagged in sRGB (or any other space), edit and save them as such, even though
the work space is Adobe RGB. And if they choose to convert the colors on opening,
the file will be converted and saved with the new profile. This really makes the
system far more foolproof – it is adaptable enough to suit the individual user’s
Photoshop skill level. Whichever option you select – convert or don’t convert – the
saved file will always be correctly tagged. The simplified Color Settings dialog gives
you everything you need to get started and hides all the controls which could trap the
unwary. The advanced settings can only be reached by clicking on the Advanced
mode checkbox.

If you have previously only used Photoshop 5.0, you will probably have to spend a
little time adjusting to what the color management policies mean as these now replace
the Profile Setup settings in 5.0. As a Photoshop 5.0 user you will probably find
yourself opening existing, tagged Photoshop 5.0 files with no problems or unexpected
warnings other than a reminder to say ‘would you like to carry on editing in that
space or convert now?’ to say that the file is in a color space other than your default
work space.

The ability to save and load custom settings is a smart feature. You can clearly con-
figure Photoshop to suit any workflow you require and save and name this setting for
future projects which require you to use the same press settings. If you look again at
the default color settings, you will notice how the list includes options such as
‘Web Graphics Defaults’ (the default setting on installation) and ‘Emulate Photoshop
4’. The Color Settings interface is a logical progression from the first Photoshop 5.0
implementation of ICC color management and in my opinion, all users will find the
system in Photoshop 6.0 and 7.0 to be a definite improvement.
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Managing the Color Settings

As your knowledge increases you will be able to customize and create your own
color settings. You might want to start by loading one of the presets present in the
Color Settings menu and modify this for a given job and customize the CMYK set-
tings to match the conditions of your repro output. As was mentioned earlier, Adobe
RGB is pre-chosen as the default work space. The CMYK setups are fairly similar to
the previous CMYK setup defaults, except there are now two CMYK separation
options available in the CMYK work space options for Euro and US printing: one
for coated and another for uncoated print stock – these default setups in Photoshop
are a pretty good starting point. The minimum you need to know is which of these
listed color settings will be appropriate for the work you are doing. And to help in
this decision, you should read the text descriptions which appear in the Description
box at the bottom of the Color Settings dialog.

Figure 4.15 Custom color settings can be loaded or saved via the Color Settings dialog. The relevant
folder will be located in the System/Application Support/Adobe/Color/Settings folder (Mac OS 9),
Library/Application Support/Adobe/Color/Settings folder (Mac OS X), Program Files/Common Files/
Adobe/Color/Settings folder (PC). When you save a custom setting it must be saved to this location
and will automatically be appended with the ‘.csf ’ suffix. When you save a color setting you have the
opportunity to include a brief text description in the accompanying dialog. A Color Settings file can be
shared between some Adobe applications and with other Photoshop users. The Mac OS X location can be
‘user’ specific, in which case the route would be: Users/username/Library/Application Support/Adobe/
Color/Settings folder.
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To save a new color setting, configure the settings to suit your intended workflow
and click on the Save... button. Locate the System/Application Support/Adobe/Color
Settings (Mac OS 9), Library/Application Support/Adobe/Color Settings (Mac OS
X), Program Files/Common Files/Adobe/Color/Settings folder (PC) and name the
setting. The file will be appended with a .csf suffix. Enter any relevant comments or
notes about the setting you are saving in the text box (see Figure 4.15). This informa-
tion will appear in the Color Settings dialog text box. You might name the setting
something like ‘Internal annual report’ and the note you write to accompany this
might say ‘Use this setting for editing and separating the digital photographs to go in
the company’s annual report’. The saved setting will now appear listed in the main
menu the next time you visit the Color Settings dialog.

Profile conversions

One problem with having multiple color spaces open at once concerns the copying
and pasting of color data from one file to another. The Profile Mismatch: Ask When
Pasting box in the Color Settings (see Figure 4.12) should ideally be checked. When
you attempt to paste color data from one document to another (or drag with the move
tool) and a profile mismatch occurs, the dialog shown in Figure 4.13 will appear,
asking you if you wish to convert the color data to match the color appearance when
it is pasted into the new destination document. If you select Convert, the appearance
of the colors will be maintained when pasting between the two documents.

If you decide to use the Preserve Embedded Profiles policy and with the Profile
Mismatch warning set to Ask When Opening, you will always be given the option of
choosing whether to convert to the current work color space or continue editing in
the document’s own color space. If you choose to continue editing in the document’s
color space, this is fine if you wish to maintain that document in its original profiled
space. There are very good reasons for always keeping CMYK files in their original
color space (because if the file has been targeted for a specific press output, you
don’t want to go changing this), but with RGB files, you will often find it more
desirable to convert everything to your default RGB work space. The ‘Convert to
RGB’ Color Settings policy will do this automatically. In the Image > Mode menu in
Photoshop 5.0 there used to be an item called Profile to Profile. That has been replaced
with the Convert to Profile command. Even when you choose to preserve the embed-
ded profile on opening, you may still want to have the means to convert non-work
space files to your current work space. I much prefer the Preserve Embedded Profile
option, because it allows me the freedom to open up any document straight away,
regardless of the space it is in, without converting. If I want to carry on editing but
eventually save the file in the current work space, I can do so at the end, using the
Convert to Profile command.
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Let’s suppose I was to open a photograph which had been captured digitally and it
was tagged with the profile of the camera’s color space. I can open this digital pho-
tograph immediately without a conversion, do all the RGB editing in this space and
yet still be able to preview a color managed image on the screen. If I carry out a
Convert to Profile command, I can instruct Photoshop to convert the image from the
tagged camera RGB space to the current work space, or indeed, to any other color
space. Convert to Profile is also useful when you wish to output to a printer for
which you have a custom-built profile but the print driver does not recognize ICC
profiles. You can have such a custom profile built for the printer by a color manage-
ment service provider and choose this profile as the space you wish to convert to.
The profile conversion will convert the color data to match the space of the output
device, but at the same time Photoshop’s color management system will convert the
colors on-the-fly to produce a color managed screen preview. You will probably see
only a slight change in the on-screen color appearance. Photoshop also attaches a
warning asterisk (*) after the color mode in the title bar to any document that is not
in the current work space. A Convert to Profile is just like any other image mode
change in Photoshop, such as converting from RGB to Grayscale mode and it is
much safer to use than the old Profile to Profile command in Photoshop 5.0. However,
if you use Convert to Profile to produce targeted RGB outputs and overwrite the
original RGB master, be warned. Photoshop will have no problem reading the em-
bedded profiles and displaying the file correctly and Photoshop 5.x will recognize
any profile mismatch (and know how to convert back to the original work space), but
as always, customized RGB files such as this may easily confuse other non-ICC
savvy Photoshop users (see Figures 4.18 and 4.19 on page 86).

Figure 4.16 Convert to Profile is similar to the old Profile to Profile command in Photoshop 5.0.
Photoshop 6.0 and 7.0 color management is different in that you don’t need to carry out a profile
conversion in order to correctly preview a file in Photoshop. It is nevertheless an essential command
for when you wish to convert color data from one profile color space to another profiled space, such
as when you want to convert a file to the profiled color space of a specific output device.
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If you find yourself in a situation where you know the profile of an opened file to be
wrong, then you can use the Image > Mode > Assign Profile command to rectify the
situation. Let’s suppose you have opened an untagged RGB file and for some reason
decided not to color manage the file when opening. The colors don’t look right and
you have reason to believe that the file had originated from the Apple RGB color
space. Yet, it is being edited in your current Adobe RGB work space as if it were an
Adobe RGB file. The Assign Profile command can assign correct meaning to what
the colors in that file should really be. By attaching a profile, we can tell Photoshop that
this is not an Adobe RGB file and that these colors should be considered as being in the
Apple RGB color space. You can also use Assign Profile to remove a profile.

Converting to the work space

If you choose either the Preserve Embedded Profiles or the Convert to Work Space
policies, you should have the Ask When Opening boxes checked, to provide a warn-
ing whenever there is a profile mismatch or a missing profile. When the Missing
Profile dialog shown in Figure 4.17 appears on screen while you are opening a file,
you can assign the correct profile and continue opening. Click on the pop-up menu
and select the correct profile. Then check the box immediately below if you also
want to convert the colors to your current work space. These settings will be remem-
bered the next time a mismatch occurs and individual settings will be remembered
for each color mode.

Figure 4.17 If the Preserve Embedded Profiles or Convert to Work Space option is checked in the
Color Settings, Photoshop will allow you to assign a profile for the file being opened and follow this
with a conversion to the current work space.
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Handling Grayscale

Grayscale image files are also managed via the Color Settings dialog. If you intend
creating grayscale images to be seen on the Internet or in multimedia presentations,
choose the Default Web Graphics color setting. The Grayscale work space will then
be set to a 2.2 gamma space, which is the same gamma used by the majority of PC
computer screens. The truth is, you can never be 100% sure how anybody who views
your work will have their monitor calibrated, but you can at least assume that the
majority of Internet users will have a PC monitor set to a 2.2 gamma. This is a darker
setting than the default 1.8 gamma used on the Macintosh system.

It is important to note that the Grayscale work space settings are independent of the settings
entered in the CMYK setup. The Photoshop prepress Grayscale work spaces should cor-
respond with the dot gain characteristics of the press. If you examine the Grayscale work
space options, you will see that it contains a list of dot gain percentages and monitor
gamma values. For prepress work select the dot gain percentage that most closely matches
the anticipated dot gain of the press. Figure 4.29 shows a range of dot gain values that can
be used as a guide for different types of press settings. This is a rough guide as to which
dot gain setting you should use on any given job. When the Advanced color settings
option is checked you can enter a custom gamma value or dot gain curve setting (see ‘Dot
gain’ later on in this chapter, page 96). The color management policy can be set to either
Preserve Embedded Profiles or Convert to Grayscale work space and again, the Ask
When Opening box should be checked. If the profile of the incoming grayscale file does
not match the current grayscale work space, you will be asked whether you wish to use
the tagged grayscale space profile, or convert to the current grayscale work space. If there
is no profile embedded, you will be asked to either: ‘Leave as is’ (don’t color manage),
assign the current grayscale work space or choose a grayscale space to assign to the file
and if you wish, convert from this to the grayscale work space.

Here is a test you can easily try yourself. Make a screen capture of something that is in
grayscale, like a plain dialog box or a grayscale image. When Photoshop opens this
screen grab, it will recognize it as a grayscale file with a missing profile. In the
absence of a profile and the color management policy is set as described above, ask
yourself which option should be used. Do you want to assign the current grayscale
work space as the missing profile? No, because you would be assigning a prepress
profile that takes into account dot gain. This is a raw screen grab and not a prepress
file. You therefore want to assign a grayscale profile that matches the space it origi-
nated in – i.e. the monitor space. And if the monitor space has a gamma of 1.8, then
choose that as the profile to assign to this grayscale screen grab. After opening, com-
pare the color managed grayscale with the original screen image to see if the two
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both look the same. If you want to know how any existing prepress grayscale image
will look like on the Web as a grayscale image, select the View > Proof Setup and
choose Windows RGB or Macintosh RGB and adjust the image levels accordingly.

Handling legacy files

When you adopt an RGB space such as Adobe RGB as the preferred work space for
all your image editing, you have to take into account that this might cause confusion
when exchanging RGB files between your machine operating in a color managed
workflow and that of someone who, for example, is using Photoshop 4.0, where the
RGB they use is based on a monitor RGB space. Figure 4.18 shows screen shot examples
of how a profiled RGB file will be displayed on another monitor if this change in
working procedure is not properly thought through. If you are sending an RGB file
for someone else to view in Photoshop, then one of six things could happen.

• They open the file in Photoshop 6.0 or 7.0 with the RGB Color Settings set to
Preserve Embedded Profiles. The file can be opened and color managed cor-
rectly even if their RGB work space is not the same as yours.

• They open the file in Photoshop 6.0 or 7.0 with the RGB Color Settings set to
Convert to RGB. If a profile mismatch occurs, the colors can be correctly
converted to their RGB work space.

• They open the file in Photoshop 5.0/5.5 with the RGB Color Mismatch Set-
tings set to the default of Convert Colors on Opening. The file will be color
managed correctly.

• They open the file in Photoshop 5.0/5.5 with the RGB Color Mismatch Set-
tings changed to Ask on Opening and they click Convert Colors.

• Before sending, you convert RGB image to Lab mode in Photoshop. This
does not lose you any image data and is a common color mode to both pro-
grams. The end user will need to convert back to their RGB.

• You convert the RGB image in Photoshop from the RGB work space to
match the RGB profile of the other user (if known) before saving. Go Image >
Mode > Convert to Profile... and select the appropriate destination RGB space
from the pop-up list. This could be something like Apple RGB. This is the
profile which will be embedded when you save.
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Figure 4.19 An untagged Photoshop 4.0 image opened in Photoshop with color management switched
off. If the RGB work space selected in Photoshop is going to be wider than the monitor RGB work
space used in Photoshop 4.0, then Photoshop will expand the RGB color space as shown here, unless
you have the Color management switched on and the Policy settings set to Preserve Embedded
Profiles or Convert to Working RGB and the Profile Mismatch Ask When Opening box is checked.

Figure 4.18 A Photoshop (5.0 or later) image (left) opened in Photoshop 4.0 (right). If the RGB work
space selected in Photoshop is wider than the basic monitor RGB space in Photoshop 4.0, then the
latter will interpret a Photoshop (5.0 or later) file as being like any other 4.0 legacy file. The RGB
colors will appear compressed and desaturated in version 4.0. The only way round this is to convert
the RGB image in Image > Mode > Convert to Profile to the monitor RGB color space used in
Photoshop 4.0.

The last two examples take into account the limitations of Photoshop 4.0 (and earlier
versions of Photoshop) not being able to understand and interpret a profiled Photoshop
RGB file and displaying the RGB data directly on the monitor without compensation.
When you save a profiled RGB file, enclose a Read Me file on the disk to remind the
person who receives the image that they must not ignore the profile information – it
is there for a reason! If you are designing images for screen display such as on the
Web, then convert your images to the sRGB profile using Image > Mode Convert to
Profile. There are potential pitfalls when opening a legacy file in Photoshop but this
will only happen if you turn all the color management settings to ‘Off’, without
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Figure 4.20 The Photoshop Advanced Color Settings dialog. Switching to the advanced mode un-
leashes full control over all the Photoshop settings. The remaining sections of this chapter will show
how you can customize the advanced color management settings.

appreciating how doing so will impact on the way the color data is going to be displayed
within Photoshop. There are specific instances where you will find it necessary to
switch color management off, but you must know what you are doing. The safe way
to turn color management off is to select Emulate Photoshop 4 from the Color Settings
menu. This will configure Photoshop to exactly match the earlier Photoshop color setup.

Advanced color settings

The advanced settings will normally remain hidden. If you check the Advanced Mode
box, you will be able to see the expanded Color Settings dialog shown in Figure
4.20. The advanced settings unleash full control over the Photoshop color manage-
ment system. Do not attempt to adjust these expert settings until you have fully
understood the intricacies of customizing the RGB, CMYK, Gray and Spot color
spaces. Read through the remaining section of this chapter first before you consider
customizing any of these settings.
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Blend RGB colors using gamma

This item provides you with the potential to the override the default color blending
behavior. There used to be an option in Photoshop 2.5 for applying blend color gamma
compensation. This allowed you to blend colors with a gamma of 1.0, which some
experts argued was a purer way of doing things, because at any higher gamma value
than this you would see edge darkening occur between contrasting colors. Some
users found the phenomenon of these edge artifacts to be a desirable trapping effect.
But Photoshop users complained that they noticed light halos appearing around ob-
jects when blending colors at a gamma of 1.0. Consequently, gamma compensated
blending was removed at the time of the version 2.5.1 update. But if you understand
the implications of adjusting this particular gamma setting, you can switch it back on
if you wish. Figure 4.21 illustrates the difference between blending colors at a gamma
of 2.2 and 1.0.

Figure 4.21 In this test a pure RGB green soft-
edged brush stroke is on a layer above a pure
red background layer. The version on the right
shows what happens if you check the Blend RGB
Colors Using Gamma 1.0 checkbox – the dark-
ening around the edges where the contrasting
colors meet will disappear.
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Desaturate monitor colors

The desaturate monitor colors option enables you to visualize and make compari-
sons between color gamut spaces where one or more gamut space is larger than the
monitor RGB space. Color spaces such as Adobe RGB and Wide Gamut RGB both
have a gamut that is larger than the monitor space is able to show. So turning down
the monitor colors saturation will allow you to make a comparative evaluation be-
tween these two different color spaces.

Customizing the RGB and work space gamma

Expert users may wish to use an alternative custom RGB work space instead of the
listed RGB spaces. If you know what you are doing and wish to create a customized
RGB color space, you can go to the Custom... option in the pop-up menu and enter
the information for the White Point, gamma and color primaries coordinates. My
advice is to leave these expert settings well alone. Do avoid falling into the trap of
thinking that the RGB work space gamma should be the same as the monitor gamma
setting. The RGB work space is not a monitor space.

Figure 4.22 The Custom RGB dialog. Use this option to create a custom RGB work space. The
above settings have been named ‘Bruce RGB’, after Bruce Fraser who devised this color space as an
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Adobe RGB is a good choice as an RGB work space because its 2.2 gamma provides
a more balanced, even distribution of tones between the shadows and highlights.
These are the important considerations for an RGB editing space. Remember, you do
not actually ‘see’ Adobe RGB. The Adobe RGB gamma has no impact on how the
colors are displayed on the screen, so long as Photoshop ICC color management is
switched on. In any case, these advanced custom color space settings are safely tucked
away in Photoshop and you are less likely to be confused by this apparent discrep-
ancy between monitor gamma and RGB work space gamma.

RGB to CMYK

The RGB color space is very versatile. An RGB master can be repurposed for any
number of uses. As we are mostly concerned with four-color print reproduction, it is
always very important to keep in mind the limitations of CMYK reproduction when
editing in RGB. Digital scans and captures all originate in RGB but they are nearly
always reproduced in CMYK. Since the conversion from RGB to CMYK has to take
place at some stage, the question is, at what stage should this take place and who
should be responsible for the conversion? We shall now look at how you can custom-
ize the CMYK setup.

There are some people who will tell you that in their expert opinion, Photoshop does
a poor job of separating to CMYK. And I bet if you ask them how they know this to
be the case, they will be stumped to provide you with a coherent answer. Don’t let
anyone try to convince you otherwise. Professional quality CMYK separations can
be achieved in Photoshop, you can avoid gamut clipping and you can customize a
separation to meet the demands of any type of press output. The fact is that Photoshop
will make lousy CMYK separations if the Photoshop operator who is carrying out
the conversion has a limited knowledge of how to configure the Photoshop CMYK
settings. As was demonstrated in the earlier sections, a wider gamut RGB space such
as Adobe RGB is better able to encompass the gamut of CMYK and yield CMYK
separations that do not suffer from gamut clipping. This is one big strike in favor of
the Photoshop 5.0+ color system. But CMYK is not a one-size-fits-all color space.
CMYK needs to be tailor-made for each and every job.
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CMYK setup

The CMYK separation setup settings must be established first before you carry out a
conversion. Altering the CMYK setup settings will have no effect on an already-
converted CMYK file. Note that in Photoshop 6.0 and 7.0, altering the CMYK setup
will not affect the on-screen appearance of an already-opened CMYK file or cause
the wrong profile information to be embedded when you save it. However, the profile
setting selected here will be the CMYK space that all future CMYK conversions will
convert to and will also be the default space to soft proof files when you chose View
> Proof Setup > Working CMYK.

If you examine the US Prepress default setting, the CMYK space says U.S. Web
Coated (SWOP). This setting is by no means a precise setting for every US prepress
SWOP coated print job, but is at least closer to the type of specification a printer in
the US might require for printing on coated paper with a web press setup. If you
mouse down on the CMYK setup pop-up list, you will see there are also US options
for web uncoated, as well as sheetfed press setups. Under the European prepress default
setting, there is a choice between coated and uncoated paper stocks. And more im-
portantly, you can choose Custom CMYK... where you can create and save your
custom CMYK profile settings to the System/ColorSync profiles folder (Mac OS 9),
Library/ColorSync folder (Mac OS X), WinNT/System32/Color folder (NT/2000),
Windows/System/Color folder (PC). The Custom CMYK dialog is shown is Figure 4.26.

Advanced CMYK settings

That’s really all you can do with the standard CMYK settings – you can make a
choice from a handful of generic CMYK profile settings or choose Custom CMYK...
This is an improvement upon the preexisting single CMYK setup found in Photoshop
5.5 or earlier. If you check the Advanced options box, you will readily be able to
select from a more comprehensive list of CMYK profile settings in the extended
menu, depending on what profiles are already in your ColorSync folder.

Conversion options

You have a choice of four Color Management Modules (CMM): the Adobe Color
Engine (ACE), Apple ColorSync, Apple CMM or Heidelberg CMM. The Adobe
color engine is reckoned to be superior for all RGB to CMYK conversions. For
example, the Adobe engine uses 20-bit per channel bit-depth calculations to calcu-
late its color space conversions.
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Figure 4.25 Each RGB image will have its own signature color space. In this example, imagine a scene
with some blue sky and bright green colors going out of gamut. The middle example shows you the
effect of a Relative Colorimetric conversion, which without some manual intervention may clip the
out-of-gamut colors. A perceptual rendering will squeeze the out-of-gamut colors to fit the CMYK
space, while preserving the relationship between the out-of-gamut colors. This rendering intent may
produce a less vibrant separation.

Figure 4.23 This example illustrates an RGB
image which was acquired and edited in RGB
using the Adobe RGB space. A CMYK conver-
sion was carried out using an ICC profile con-
version from Adobe RGB and the Perceptual (Im-
ages) rendering intent.

Figure 4.24 The image was assembled with a
gradient chosen to highlight the deficiencies of
sRGB. The master RGB file was then converted
to fit the sRGB color space. A CMYK conversion
was made. sRGB is weaker at handling cyans and
greens. There is also a slight boost in warmth to
the skin tones.
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Rendering intent

Perceptual (Images) rendering is an all-round rendering method that can also be used
for photographic images. Perceptual rendering compresses the out-of-gamut colors
into the gamut of the target space when colors are out of gamut, while preserving the
visual relationship between those colors, so they do not become clipped. More compression
occurs with the out-of-gamut colors, smoothly ramping to no compression for the in-
gamut colors. Figure 4.25 illustrates how these different rendering methods work.

The Saturation (Graphics) rendering intent preserves the saturation of out-of-gamut
colors at the expense of hue and lightness. Saturation rendering will preserve the
saturation of colors making them appear as vivid as possible after the conversion.
This is a rendering intent best suited to the conversion of business graphic presenta-
tions where retaining bright, bold colors is of prime importance.

Relative Colorimetric has always been used as the default rendering intent in the
manual built-in CMYK setup in Photoshop 4.0 and earlier versions, and is the default
rendering intent utilized in the Photoshop color settings. Relative Colorimetric
rendering maps the colors that are out of gamut in the source color space (relative to
the target space) to the nearest ‘in-gamut’ equivalent in the target space. When doing
an RGB to CMYK conversion, an out-of-gamut blue will be rendered the same CMYK
value as a ‘just-in-gamut’ blue. Out-of-gamut RGB colors are therefore clipped. This
can be a problem when attempting to convert the more extreme range of out-of-
gamut RGB colors to CMYK color and it is advisable that you consider using the
soft proofing view of the space you are converting to, in order to check for possible
gamut clipping. While in RGB mode, an image can be manually color adjusted to
improve the quality of the final RGB to CMYK conversion.

Absolute Colorimetric maps in-gamut colors exactly from one space to another with
no adjustment made to the white and black points. This rendering intent can be used
when you convert specific ‘signature colors’ and need to keep the exact hue satura-
tion and brightness, like the colors in a commercial logo design. This rendering in-
tent is seemingly more relevant to the working needs of designers than photogra-
phers. However, you can use the Absolute Colorimetric rendering intent as a means
of simulating a target CMYK output on a proofing device. Let’s say you make a
conversion from RGB to CMYK using either the Relative Colorimetric or Percep-
tual CMM and the target CMYK output is a newspaper color supplement printed on
uncoated paper. If you use the Absolute Colorimetric rendering intent to convert
these ‘targeted’ CMYK colors to the color space of the proofing device, the proofer
will reproduce a simulation of what the printed output on that stock will look like.
For more about targeted proofing, see the following chapter on file management and
outputs.
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Black Point Compensation

This will map the darkest neutral color of the source RGB color space to the darkest
neutrals of the destination color space. When converting RGB to CMYK, it is rec-
ommended you always leave this item checked. If you happen to be using Photoshop
5.x, it can pay to experiment with BPC on and BPC off when you test a new profile
– some RGB to RGB profile conversions may be adversely affected and you can end
up with weak, muddy blacks. These Black Point Compensation issues have been
corrected in versions 6.0 and 7.0.

Use Dither (8-bit per channel images)

Banding may occasionally occur when you separate to CMYK, particularly where
there is gentle tonal gradation in bright saturated areas. Banding which appears on
screen does not necessarily always show in print and much will depend on the coarse-
ness of the screen used in the printing process. However, the dither option will help
reduce the risks of banding when converting between color spaces.

Creating a custom CMYK setting

If you wish to make precision separations, you can generate your own custom CMYK
profile in the Color Settings in either the standard or advanced mode. Choose Custom
CMYK... from the CMYK Work Space menu. Figure 4.26 shows the Custom CMYK
dialog. This is better known as the familiar ‘Classic’ Photoshop CMYK setup. You
can enter here all the relevant CMYK separation information for your specific
print job. Ideally you will want to save each purpose-built CMYK configuration
as a separate color setting for future use and label it with a description of the
print job it was built for.

Once the CMYK setup has been configured, the View > Proof Setup > Working
CMYK and the View > Gamut Warning (for the CMYK space selected in the Proof
setup) will enable you to pre-adjust an image to ensure the out-of-gamut colors are
manually brought into gamut while still in RGB mode and before making a conver-
sion. If this CMYK preview suggests that the CMYK conversion is not going to give
you the best color rendering of some of the image colors, you have the opportunity to
override this. For example, while the master image is in RGB mode, you can choose
Working CMYK in the Proof setup (or any other CMYK color space in the list) and
make an image color adjustment to bring these out-of-gamut RGB colors into CMYK
gamut. See Chapter Nine for more detailed advice on how to do this. See also Chapter
Five for more information on the Photoshop soft proofing options.
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Figure 4.26 Select the Cus-
tom CMYK... option at the top
of the pop-up menu list. This
opens the dialog box shown
opposite, where you can enter
the specific CMYK setup infor-
mation to build a custom tar-
geted CMYK setting. When the
advanced mode box is checked,
you can choose from a wider
range of pre-loaded CMYK
profile settings. The various
CMYK setup options are dis-
cussed in this chapter.

Ink Colors

Where it says Ink Colors, you should choose the setting recommended by your press
for the paper stock to be used. For example, European Photoshop users can choose
from Eurostandard (coated), (uncoated), or (newsprint). These generic ink sets will
do fine for most print jobs. If your printer can supply you with a custom ink color
setting, then select Custom... from the Ink Colors menu, this will open the dialog
shown in Figure 4.27.
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Dot gain

Dot gain refers to the spread
of ink on the paper after it is
applied and is very much de-
pendent on the type of press and the paper stock being used. The dot gain value
entered in the CMYK setup will affect the lightness of the color films generated
from the CMYK file which will be used to make the final plates. The higher the dot
gain, the lighter the film needs to be, this is because less ink needs to be laid down to
produce the correct sized halftone dot. So therefore a high dot gain value, such as

Figure 4.27 The Custom Ink Col-
ors dialog. For special print jobs
such as where non-standard ink
sets are used or the printing is be-
ing done on colored paper, you can
enter the measured readings of the
color patches (listed here) taken
from a printed sample on the ac-
tual stock that is to be used.

Figure 4.28 If you select Dot
Gain: Curves... from the CMYK
setup shown in Figure 4.30, you
will open the Custom Dot Gain
dialog shown opposite. If your
printer is able to provide dot gain
values at certain percentages, then
you can enter these here. Dot gain
may vary on each ink plate. If you
deselect the All Same box, you can

enter the dot gain for each
individual plate. Note that
when you select Custom
Dot Gain... from the Gray-
scale work space menu, a
similar dialog appears. If you
are preparing to save a color
setting designed for separat-
ing prepress CMYK and gray-
scale files, you will want to
check that the black plate
dot gain setting is consistent.
Note that dot gain can vary
for each plate and that the
black plate dot gain may be
slightly different.
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that used for newsprint, will cause the CMYK conversion to produce light-looking
films. A lower dot gain value such as that used for a coated paper stock will mean
that the films will look darker.

The dot gain value will not affect the way the image appears proofed on the screen.
This is because Photoshop’s color management system will always use the informa-
tion entered in the CMYK setup to calculate the screen appearance and to provide
you with an accurate soft proof of the expected output. But as was pointed out, if you
were to compare the outputted films from the previous two examples, the films would
actually have very different densities. Dot Gain Curves enable you to input more
precise information about the dot gain (choose Curves from the pop-up menu next to
Dot Gain). If you select the Dot Gain Curves option, you can enter custom settings for the
composite or individual color plates. In the preparation of this book I was provided with
precise dot gain information for the 40% and 80% ink values (see Figure 4.28).

Separation options

This controls what type of separation will be used and the total ink limits permitted.
The default Photoshop setting is GCR, Black Generation: Medium, Black Ink Limit
100%, Total Ink Limit 400% (which is way too high), UCA Amount 0%. If you ask
your printer what separation settings they use and you are quoted the above figures,
you know they are just reading the default settings to you from an (unconfigured)
Photoshop machine and they either don’t know or don’t want to give you the answer.
If you are creating a custom CMYK setting it is more likely you will want to refer to
the table in Figure 4.29 for guidance here. Or if you prefer, stick to using the prepress
Adobe CMYK setting that most closely matches the output (US Sheetfed/Web Coated/
Uncoated).

UCR (Undercolor Removal) is said to be the preferred separation method in use
today and a lot of commercial printers will use this separation method on their systems.
UCR replaces the cyan, magenta and yellow ink in just the neutral areas with black
ink. The UCR setting is also favored as a means of keeping the total ink percentage
down on high-speed presses, although it is not necessarily suited for every job.

Low key subjects and high quality print jobs are more suited to the use of GCR
(Gray Component Replacement) with a small amount of UCA (Undercolor Addi-
tion). GCR separations remove more of the cyan, magenta and yellow ink where all
three inks are used to produce a color, replacing the overlapping color with black
ink. The use of undercolor addition will add a small amount of color back into the
shadows and is useful where the shadow detail would otherwise look too flat and
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lifeless. The percentage of black ink used is determined by the black generation
setting (see next heading). In the case of Photoshop conversions, you are better off
sticking with the default GCR, a light to medium black generation with 0–10% UCA.
This will produce a longer black curve and improved image contrast.

Black generation

This determines how much black ink will be used to
produce the black and gray tonal information. A light
or medium black generation setting is going to be best
for most photographic images. I would advise leaving it
set on Medium and only change the black generation if
you know what you are doing. As a matter of interest, I
always use a maximum black generation setting when I
separate all the dialog boxes which appear printed in this
book. When I separated the screen grab shown in Fig-
ure 4.27, a Maximum black generation separation was
applied, so the black plate only was used to render the
neutral gray colors. Consequently any color shift at the
printing stage will have no impact whatsoever on the neu-
trality of the gray content. I cheekily suggest you inspect
other Photoshop books and judge if their palette and dia-
log box screen shots have reproduced as well as the ones
in this book!

Opening CMYK and Lab files

CMYK files should not be converted back and forth to RGB. I always prefer to
keep an RGB master and convert to CMYK using a custom conversion to suit each
individual press requirement. Converting from one CMYK space to another is not
normally recommended but in the absence of an RGB master, this will be the only
option available. Photoshop makes the process of CMYK to CMYK conversion easier
to accomplish. Just specify the CMYK profile to convert to in the Convert to Profile
dialog box. The Preserve Embedded Profiles policy means that incoming tagged CMYK
files can always be opened without converting, thus preserving the numbers, while pro-
viding you with an accurate soft proofed screen preview. I do ensure that all my files
have an ICC profile embedded, except when I am preparing images for the Web. In
the case of the Lab color mode, if a Lab file is missing an ICC profile, it will open
without interruption. Lab color mode is therefore assumed to be a universally under-
stood color space, and it is argued by some that saving in Lab mode is one way of
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Figure 4.29 These separation guidelines reflect a typical range of settings one might use for each
type of press output. These are guidelines only and reflect the settings you will already find in Photoshop
for each of the above. For precise settings, always consult your printer.

surmounting all the problems of mismatching RGB color spaces. But one of the
problems with using Lab as a master space is that it is so large and there can be a lot
of gaps between one color and the next when you save in Lab mode using 8 bits per
channel.

Information palette

Given the deficiencies of the color display on a monitor, such as its limited dynamic
range and inability to reproduce colors like pure yellow on the screen, color profes-
sionals will often rely on the numeric information to assess an image. Certainly when
it comes to getting the correct output of neutral tones, it is possible to predict with
greater accuracy the neutrality of a gray tone by measuring the color values with the
eyedropper tool. If the RGB numbers are all even, it is unquestionably gray (in a



Adobe Photoshop 7.0 for Photographers       <www.photoshopforphotographers.com>

46

Figure 4.31 The Adobe RGB work space is a virtual space – you cannot actually see it. The monitor
profile is generated by the Adobe Gamma control panel. This profile converts the Adobe RGB data
‘on-the-fly’ to render the monitor screen image. The monitor RGB space is smaller than the Adobe
RGB space. Using the monitor alone as your guide, you may not be able to see all the colors that end
up in print. Nonetheless, they are preserved in the Adobe RGB edit space. Another Photoshop 5.0+
user may be using a different RGB space, like ColorMatch RGB. No matter, Photoshop converts with
high precision from one space to another. When the RGB to CMYK conversion occurs, it is made
from an RGB file which has been carefully color managed throughout. In this example, CMYK gamut
clipping is avoided, because the limiting monitor RGB space has been taken out of the equation.

Figure 4.30 This and Figure 4.31 show a typical use of profiled, RGB workflow. The original subject
is shot using daylight. The digital camera used to capture this scene has its own color characteristics
and the gamut of the captured image is constrained by what colors the camera is able to capture in
RGB. Photoshop is able to read the embedded ICC camera profile tag and converts the colors to the
Adobe RGB work space. This RGB file can now be shared directly with other Photoshop 5.0+ users
editing in Adobe RGB color.
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standard/linearized RGB editing space such as Adobe RGB). Interpreting the CMYK
ink values is not so straightforward. When printing a neutral gray, the color is not
made up of an even amount of cyan, yellow and magenta. If you compare the color
readout values between the RGB and CMYK Info palette readouts, there will always be
more cyan ink used in the neutral tones, compared with the yellow and magenta inks.
If the CMY values were even, you would see a color cast. This is due to the fact that the
process cyan ink is less able to absorb its complementary color – red – compared to
the way magenta and yellow absorb their complementary colors. This also explains
why a CMY black will look reddish/brown, without the help of the black plate to add
depth and neutrality.

The ICC color managed workflow

Now that you have read through to the end of this chapter, see if the diagram of a
typical workflow shown in Figure 4.30 makes sense. This represents one possible
route an image file might take from the point of digital capture through to the CMYK
conversion. If you assume everyone who handles such a file is using an ICC color
managed workflow, the image data only has to be converted twice: once from the
RGB camera space to the RGB work space and then from the RGB work space to the
CMYK output space. In the Figure 4.31 example, an additional RGB to RGB con-
version takes place because another Photoshop user receiving the Adobe RGB file is
working in an alternative RGB work space. But as you can see, the Photoshop color
management system makes it possible to accurately preview the colors on screen
and minimize the number of color conversions that have to take place to get the most
reliable and fullest gamut color reproduced in the final printed image.


